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AirMagnet Plannerの使用

Planner User Interface 

ナビゲーションバー

様々な画面やユーティリティの起動パッドとして機能します。ナビゲーションバーのオプションは、
ソフトウェアのライセンスによって異なります。

ナビゲーションバーの一部のオプションは、AirMagnet Planner を使用する際に利用できない
機能を参照しています。

[Planner]をクリックして[Planner]ビューを開きます。

File メニューオプション

[Planner]ビューでは、[File]メニューに以下のオプションが用意されています。
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メニューオプション 説明

New Project... 新規プロジェクトウィザードウィンドウを開き、新しいプランナープロジェクトを作成することが
できます。

Open Project... 既存のプランナープロジェクトを開きます。

Save 現在のプロジェクトに加えた変更を保存します。

Save Project 
As... 現在のプロジェクトを別の名前で保存します。

Close Project 現在のプランナープロジェクトファイルを閉じます。

Configure... [Configuration]ダイアログボックスが開き、AirMagnet Planner のさまざまなパラメータを設定
できます。

New Plan... 現在のプランナープロジェクトに新しいプランを作成します。

Save Plan 現在のプランをプランナープロジェクト内に保存します。

Save Plan As... 現在のプランを現在のプランナープロジェクト内で別の名前で保存します。

Extract Wall 
Objects from 
CAD... 

プロジェクトのCADイメージ（.dwg）をインポートした場合、このオプションを選択するとCAD図
面からプランナー壁オブジェクトを作成する為のダイアログが開き、レイヤーを選択したり壁
を設定したりできます。
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Export to 
CAD... 

プロジェクトにCADイメージ（.dwg）をインポートした場合、このオプションを使用すると、APや
壁データとともにイメージをエクスポートできます。

Antenna 
Manager... 

[Antenna Manager]ダイアログを開き、アンテナパターンテンプレートのカスタマイズや変更が
できます。

Planner 
Configuration... 

[Planner Configuration]ダイアログを開き、Planner の表示の様々な側面をカスタマイズでき
ます。

Planner Object 
Manager... 

[Planner Object Manager]を開き、ユーザーがプラン内の壁とエリアのタイプのリストを表示で
きるようにします。

Recent Projects 以前に開いたプロジェクトのリストを提供します。リストを選択するとプロジェクトが開きます。

Multi Floor 
Planner 

Multi Floor Plannerが開きます。

Exit AirMagnet Plannerを閉じます。

View メニューオプション

[View]メニューには以下のオプションがあります。 
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メニューオプション 説明

Zoom In 
マップウィンドウの現在のフロアマップの表示を拡大します。ツールバーの  (Zoom In)と

同じ動作をします。

Zoom Out 
 (Zoom Out)マップウィンドウの現在のフロアマップの表示を縮小します。ツールバーの

と同じ動作をします。

Zoom to Fit 
現在のフロアマップをマップウィンドウにフィットさせます。ツールバーの  (Zoom Fit)と

同じ動作をします。

Zoom to Actual 
Size 現在のフロアマップを、実際の印刷縮尺に合わせます。

Set Zoom... [Set Zoom]ダイアログボックスが開き、マップの表示倍率を指定できます。

Show CAD 
Layers... 

CADイメージのどのレイヤーを表示するか、またイメージに複数のレイアウトがある場合はど
のレイアウトを表示するかを選択できます。この機能は、[Display]ビューで画像を右クリック
したときにも利用できます。 

Toolbars and 
Docking 
Windows 

レジェンド、ステータスバーを表示または非表示にし、ツールバーをデフォルト設定にリセット
します。

Show Rulers マップウィンドウの端に沿ったルーラーを表示または非表示にします。

Show Grids マップウィンドウにグリッドを表示または非表示にします。

Invert Legend 
Colors レジェンドの配色を反転します。

Filter APs APをフロアプランに配置すると、このオプションにより[Filter AP]ダイアログが開き、ヒート
マップ生成に APを含めるか除外するデータ ファイルを作成できます。

Overlap 
[Overlap]ボタンと同じです。 信号のオーバーラップまたはチャネル干渉のオーバーラップを
示します。選択したデータタイプに基づいて、Overlapでは、オーバーラップしないすべての情
報が除外され、オーバーラップするデータのみが表示されます。

Overall [Overall]ボタンと同じです。デフォルトのヒートマップは、全体的な信号強度のカバレッジを示
します。

View Per 
Channel 

[Channel/SSID]ビューがチャネルに設定されている場合に有効になります。ツールバーの
[Per Channel]オプションと同じです。データをチャネルごとに表示します。各チャネルを異なる
色で表示します。このオプションを有効にすると、チャネルリストでチャネルに異なる色が割り
当てられます。

Per SSID 
[Channel/SSID]ビューがSSIDに設定されている場合に有効になります。ツールバーの[Per 
SSID]オプションと同じです。データをSSIDごとに表示します。各SSIDを異なる色で表示しま
す。このオプションを有効にすると、チャネルリストでSSIDに異なる色が割り当てられます。

Show AP List 現在のプランに含まれるすべてのAPのリストを表示します。これにより、リスト内の各APの
基本設定を簡単に管理できます。

Re-Sequence 
AP Numbering 

デフォルトのナンバリングスキーム（"AP-#"）に適合するマップ上に配置されたすべてのAP
のナンバリングを再順序付けし、設計プロセス中に発生した可能性のあるナンバリングの
ギャップを削除します。

Refresh ヒートマップを生成または更新します。フロアプラン上に1つ以上のAPを配置する必要があり
ます。
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Toolbar 

ツールバーには頻繁に使用するツールが含まれており、その一部は[File]メニューや[View]メニューに
あるものと同じです。

以下のツールバーのスクリーンショットは、ドッキングされていない状態を示しています。ツールバーの
ドッキングを解除するには、ツールバーの左端にあるハンドルをドラッグします。

アイコン ツール名 説明

Project Wizard 新しいプロジェクトを作成します。

Open Project 参照してプロジェクトを開きます。

Save 開いているプロジェクトを保存します。

Configure プロジェクトの設定ウィンドウを開きます。

Select カーソルツールを選択し、特定の項目を選択・変更できます。

Zoom In サイトマップの表示を拡大します。

Zoom Out サイトマップの表示を縮小します。

Zoom Fit サイトマップをマップウィンドウに合わせます。

Actual Size ズーム値をサイトマップファイルの実際のサイズに設定します。

Create AP 新しいAPを作成し、マップに配置することができます。

Measure Mode 場所に合わせてサイトの寸法を再調整できます。

Create Wall 壁のタイプを選択し、サイトの壁を描画できます。

Create Rectangular 
Attenuation Area 

エリアタイプ（キュービクル、オフィスなど）を選択し、エリアの四角形セクショ
ンを描画できます。

Create Arbitrary 
Attenuation Area 

四角形エリアと同じですが、四角形の描画に限定されません（Create Wall
ツールのように描画します）。

Create Elliptical 
Attenuation Area 

エリアのタイプ (キュービクル、オフィスなど) を選択し、楕円形のエリアを描
画できます。

Create Rectangular 
Coverage Area 

四角形のカバレッジエリアを描画できます。 このエリアは、Planner Advisor
によってのみ使用されます。

Create Rectangular 
Excluded Area 

四角形の除外領域を描画できます。 このエリアは、Planner Advisorによって
のみ使用されます。

Create Arbitrary 
Coverage Area 

任意のカバレッジエリアを描画できます。 このエリアは、Planner Advisorに
よってのみ使用されます。
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Create Arbitrary 
Excluded Area 

任意の除外エリアを描画できます。 このエリアは、Planner Advisorによって
のみ使用されます。

Create Elliptical 
Coverage Area 

楕円形のカバレッジエリアを描画できます。 このエリアは、Planner Advisorに
よってのみ使用されます。

Create Elliptical 
Excluded Area 

楕円形の除外エリアを描画できます。 このエリアは、Planner Advisorによっ
てのみ使用されます。

Clear All Objects ダイアログが開き、配置されているすべてのオブジェクト、または特定のタイ
プのすべてのオブジェクト（AP、減衰エリア、壁など）を削除できます。

Advisor Planner Advisor ツールを開きます。

Refresh ヒートマップの生成と更新

Overlap 
マップウィンドウでカバレッジの重なりを表示または非表示にします。Display
ビューで使用できます。

Filtering プランナープロジェクトからAPデータをフィルタリングします。

Tools SignalとDHCPツールを開きます。

Calculator 電卓ツールを開きます。

Project Window 

プロジェクトウィンドウには、現在のプロジェクトに含まれるすべてのプランが表示されます。 

Plannerビューのプロジェクトウィンドウには、以下のコンポーネントが含まれます： 

• Tools: 現在のプロジェクトファイルに含まれるアクティブなプランを追加、削除、修正、保存
するためのボタンがあります。

• Plans: 現在のプロジェクトファイルに含まれるアクティブなプランを表示します。 
選択したプランは、常にビューに表示されます。

• Right-Click Pop-Up Menu: 以下の「Right-Click Pop-Up Menu 」を参照してください。

Right-Click Pop-Up Menu 

Plannerビューのプロジェクトウィンドウにもポップアップメニューがあり、メインエントリーを右クリック
すると有効になります。
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メニュー
オプション

説明

New 新しいプランを作成するためのプランダイアログボックスを開きます。

Save As 現在のプランを保存し、必要に応じて名前を変更し複製ができます。

Delete 選択した（右クリックした）項目を削除します。

Properties... 選択したプランのプロパティを変更できます。

Channel Tab 

下図はChannelタブを選択した場合のデータウィンドウです。特定のAPまたはChannelにチェックを
入れたり外したりすることで、マップ上の表示を変更して解析の焦点を絞ることができます。

SSID Tab 

下の画像は、SSIDタブが選択されているときのデータウィンドウを示しています。
特定の SSID または AP のチェックを入れたり外したりすることで、Channelタブと同様に解析を
絞り込むことができます。
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AP Data Properties 

APプロパティ（チャネルやメディアタイプなど）は、いくつかの異なる方法で表示できますが、
プロパティは Planner ビューでのみ編集できます。

• Plannerビューで、サイトマップ上の AP を右クリックし、「AP Properties...」を選択

します。このプションにより、プロパティを編集できるようになります。

• データウィンドウのSSIDまたはChannelツリーのいずれかを展開します。APを右ク

リックし、「AP Properties...」を選択します。(編集はDisplayビューでも可能です。）

• Displayビューで、サイトマップにある AP を右クリックし、「AP Properties...」を選択

します。

各プロパティ項目についての説明は、APをプランに追加するを参照してください。
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Map Window 

下の画像は、Plannerビューのマップウィンドウとサイトマップを表示したものです。
プロジェクトウィンドウでプランを選択すると、プランが表示されます。したがって、表示されている
プランを変更したい場合は、左上のリストからプランを選択してください。
デフォルトでは、Plannerプロジェクトを開くと、マップウィンドウでサイトマップが自動的に開きます。 
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計画を開始する前に、プロジェクトやサイトマップが投影したい場所と一致していることを確認する
ことが重要です。

Planner Configuration 

メニューバーの [File]ドロップダウンには[Planner Configuration...]があり、AirMagnet Planner の

いくつかの側面をカスタマイズできます。以下のセクションでは、Planner Configurationメニューの

各タブについて説明します。

• Usability

• Sampling Density

Usability 

[Usability]タブでは、サイトプランを生成および処理する際のプランナーの動作を変更する
いくつかの設定を変更できます。
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オプション 説明

Clear signal 
distribution when 
switching tools 

この機能を有効にすると、ユーザーがツールバーから新しいツールを選択するたび
に、Planner のヒートマップがリセットされます。

Auto prompt after 
placing an AP 

このオプションを有効にすると、Planner は新しい AP がマップに配置されるたびに
[AP Properties]ダイアログを開きます。

Auto processing data 
after Advisor result 

これを有効にすると、Planner Advisorが処理を終えると、Plannerは自動的にシグナ
ルカバレッジヒートマップを生成します。

Show AP label これを有効にすると、配置された AP の下にラベルが表示されます。これらのラベル
には、APの名前、メディアタイプ、チャネルが含まれています。

Undo buffer size 
このフィールドでは、Planner の元に戻すバッファに保存される操作の数を指定でき
ます。デフォルトでは、[Ctrl+z]を繰り返し押すことで20回まで操作を取り消すことが
できます。やり直しは[Ctrl+y]を使用して実行できます。

Sampling Density 

[Sampling Density]タブでは、信号データを処理する際の高精度プランナーをコントロールすることが
できます。スライダーをバーの "Low Density "端に近づけると、信号データの処理にかかる時間は
短くなりますが、処理範囲も狭くなります。逆に、スライダーを「High Density」の方に動かすと、
より詳細な結果が得られますが、処理に時間がかかります。

また、「Use recommended sampling distance」オプションをチェックすると、プランナーが自動的に使用
する推奨値を計算します。
この値は、使用中のサイトプランのサイズと複雑さに基づいて生成されます。大きなマップでは、
処理時間を短縮するために推奨値が大きくなります。
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Wall / Area Object Manager 

 Multi Floor Planner: Wall/Area Configuration 

AirMagnet Planner プロジェクトで使用できる壁とエリアのタイプを変更します。 

File > Planner Object Manager をクリックします。

(Multi Floor Planner の場合: Tools > Configure Walls/Areas)

任意のフィールドをクリックすると、各壁の値を変更することができます。右上のボタンは、壁やエリアを
作成したり、リストから削除することができます（アクティブなタブの選択 WallまたはArea に応じて）
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アイコン ツール名 説明

Add 新しいエリアや壁の種類をリストに追加します。

Delete 既存のエリアまたは壁のタイプを削除します。

Default Plannerのデフォルトリストを復元します。 これにより、すべての値がリセットされ、作成されたカス
タムエリアや壁タイプが削除されます。

dB Dropの簡単な説明については、「dB Drop Value」を参照してください。

減衰指数については、「Attenuation Index」を参照してください。

Attenuation Index(減衰指数)

エリアの減衰指数とは、RFトラフィックがエリアを移動する際に発生する信号劣化の割合を指します。
値が大きいほど信号強度が低下するため、エレベーターシャフトはキュービクルよりもかなり高い指数
を示します。減衰指数が高いほど低下が大きいことを示しますが、この値は dB 低下値と同一ではな
く、パーセンテージでもないことに注意することが重要です。

dB Drop Value 

壁の dB ドロップ値はエリアに使用される減衰指数と同様に機能しますが、値はまったく異なります。 
壁の dB ドロップは、信号が物体を通過するときに受ける強度の低下を指します。この値は dB 単位で
測定されます。ユーザーは独自の壁のタイプを入力し、壁の dB 降下を簡単に求めることができます。
これを行うには、壁の両側で信号強度を測定し（例えば AirMagnet Survey を使用）、両側の差を計算
するだけです。結果の差が壁の dB ドロップ値となります。

アンテナマネージャーの使用

AirMagnet Planner の内蔵アンテナマネージャーを使用すると、ワイヤレスデバイスが使用するアンテ
ナのタイプを選択できます。 また、アンテナが生成するパターンを照合できるアンテナパターン変更
ツールも含まれています。

アンテナプロパティの表示

通常、AirMagnet Planner に含まれるプリセットのリストから、お使いのアンテナを見つけることができます。

アンテナのプロパティを表示するには、以下の手順に従ってください。

アンテナのプロパティを表示するには:

1. File > Antenna Manager...クリックします。

2. Antenna Managerが開きます。
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3. 上に示したように、アンテナ検索を絞り込むためのいくつかのフィルターオプションが
ウィンドウの上部に表示されています。

フィールド 説明

Vendor
このフィールドをクリックすると、表示させたいアンテナベンダーをチェックできます。ネット
ワークが特定の会社のアンテナだけを使用している場合、それに応じて検索を絞り込むこ
とができます。

Band このリストでは、どのメディアタイプで検索を絞り込むかを選択できます。

Plane Azimuth（水平/上面図）またはElevation（垂直/側面図）を使ってアンテナだけを
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表示するか、あるいは単に "All "のままですべてを表示するかを選択できます。

Create
このフィールドでは、探しているパターンが自分でカスタマイズしたもの（User Defined）な
のか、AirMagnet Planner で事前定義されたもの（Pre Defined）なのかを指定できます。

4. 内蔵アンテナパターンを表示するには、表示したいアンテナをクリックし、Displayをクリック
します。 Antenna Patternダイアログが表示されます。

5. 右下の「Tracker」ボックスで、このパターンを表示するために使用するオプションのみを
変更できます。 ボックスには 3 つのオプションが含まれています:

• Show Tracker： フィールド上の表示ポイントをオフにして、フィールドラインのみを表示
できるようにします。 このボックスがチェックされていない限り、他の 2 つのオプションは
使用できません。

• Show Handle : フィールド上の黄色の点を結ぶ直線と、赤い曲線フィットラインが表示され
ます。
これらの黄色の点は、円の中心から外側に放射状に伸びる線上にのみ表示され、
フィールドに大きな変更を加えることができます。

• Show Assist : 赤い曲線で結ばれた青い点のみを表示します。 これらの青い点を
使用すると、ハンドル ポイント間のフィールドを微調整できます。[Show Handle]を有効に
して、最終的なフィールドビューを表示することもできます。

Note: 内蔵アンテナのパターンを変更することはできません。 パターンを変更するには、以下の手順に
従って独自のアンテナを作成する必要があります。 

カスタムアンテナパターンの作成

アンテナがプリセットにリストされていない場合は、カスタマイズしたアンテナ パターンを作成でき
ます。 これにより、AirMagnet Planner は目的のパターンを正確に投影できるようになります。

Note: 新しいアンテナパターンを作成するには、既存のパターンをコピーする方が簡単かもしれません。 
これを行うには、Antenna Manager のアンテナパターンのリストから類似のパターン形状を選択し、
New をクリックします。アンテナマネージャは、選択したパターンに基づいて新しいアンテナパターンを
作成します。その後、必要に応じてパターンを編集できます。

新しいアンテナパターンを作成するには:

1. File>Antenna Manager... をクリックします。

2. Antenna Manager から、New ボタンをクリックします（または、類似のパターンを
見つけてNew をクリックします）。Antenna Pattern ビューが表示されます。
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3. Antenna Nameには、新しいアンテナパターンの任意の名前を入力します。

4. 以下の表の説明に従ってアンテナのプロパティを設定します：
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フィールド 説明

Vendor アンテナのベンダー名を入力します。

Band 2.4 GHz または 5 GHz を選択します。

Plane 作成するパターンのタイプに応じて、方位面 (水平) または仰角面 (垂直) を選択できます。

Ring 
Count 

この値は、フィールド図に表示される同心円の数を変更します。製品のアンテナパターン図のリングの数を
数え、その数をここに入力します（最も外側のリングを含む）。

0 dB 
Ring # 

製品のアンテナパターン図を使用して、中心から 0 dB リングまでのリングの数を数え、ここに値を入力し
ます。

dB 
Interval

製品のアンテナ図を使用して、各リング間の dB 間隔を決定し、その値をここに入力します。例えば、各リ
ング間に5dBの間隔がある場合、ここに入力する値は5です。

0 Ring 
dB 
Gain 

製品のアンテナ図を使用して、グラフがいずれかの点でピークゲインに達する場合は、0 を入力します。グラ
フがピークゲインに達しない場合は、アンテナベンダのユーザーマニュアル/データシートに記載されている
ピークゲイン値を入力してください。以下の例では、0 dBリングが太字で強調表示され、矢印で示されていま
す。以下の最初の例では超えていませんが、2番目の例では超えています。

5. 必要に応じてハンドルポイントとアシストポイントをドラッグしてアンテナパターンの描画を調整
します。

ハンドルポイント(黄色のポイント)は大きな変更を可能にし、アシストポイント(青色のポイント)は
描画の微調整を可能にします。

Note: アンテナパターンを描くためのヒント: 製品のアンテナパターン図の電子画像を入手して開きます。 
Antenna Managerで、画像のサイズを図 (アンテナの図面) と同じサイズに設定します。
製品のアンテナパターンの輪郭を透明シートにトレースします。 Antenna Managerに透明度をオーバーレイ
します。 ハンドルをドラッグしてトレース画像に合わせます。
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Note: フィールドに大きな変更を加えるには、[Show Assist] ボックスのチェックを外すのが最も簡単な場合が
あります。 Show Assist を再チェックして図面を微調整します。

6. [OK]をクリックして、新しいアンテナパターンを保存します。 新しいアンテナパターンが
Antenna Managerに選択項目として表示されます。

Note: 新しいアンテナパターンを使用するには、まずフロアプラン上に AP を配置する必要があります。 
AP をダブルクリックしてプロパティを開きます。AP Properties ダイアログの Pattern をクリックします。

新しいパターンを削除したい場合は、そのパターンを選択して「Delete」をクリックします。なお、
あらかじめ設定されているパターンは削除できません。

Planner Projects 

製品機能

AirMagnet Surveyは以下の主な機能を提供します: 

• サイトマップのインポート機能により、既存の建物の地図画像をインポートして、敷地に
合わせた仕様を適切に計画することができます。

• Drawing toolsにより、オフィス環境に合わせたサイトマップを簡単に作成できます。
あらかじめ設定されたさまざまな素材（キュービクル、乾式壁、レンガなど）から、内蔵の
減衰指数とともに選択することもできますし、上級ユーザーであれば、独自の素材をカス
タムメイドすることも可能です。

• Antenna Managerには、あらかじめ設定されたアンテナフィールドパターンがあります。
また、独自のパターンをカスタム生成し、APの高さやフィールドの方向を調整することも
できます。

• レポートジェネレーターは、プランナーのサーベイ結果に基づいてカスタムレポートを作
成します。プロジェクトの詳細を記載した文書を作成し、エクスポート、印刷、または他の
人に電子メールで送信できます。
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• 調整可能なサンプリング密度により、投影精度をカスタマイズし、より正確な結果を
得ることができます。

• 2 つの表示オプションにより、チャネルまたは SSID ごとにサイトの RF データを表示
および解析できます。AP カバレッジ、ローミング境界、チャンネル割り当て / 干渉、
ノイズの影響など、WLANの欠陥を簡単に特定できます。

• ズームオプションを使用すると、サイトの特定の部分にズームインして、問題点とその
修正方法を判断することができます。

• カラースペクトルとグラデーションを使用したグラフィカルデータ表示により、さまざまな
ソース（つまり、AP、SSID、チャネル）からの RF データを理解し、区別することが容易
になります。 これにより、WLAN の決定を「仮説」ではなく「事実」に基づいて行うことが
できます。

• Planner Advisorは、簡単なレイアウト変更でAPの理想的な配置を決定するのに役立ち
ます。使いやすいAdvisorツールは、Advisorが正確な評価を行うための情報をできる
だけ多く含んだサイトプランを生成するのに役立ちます。

• Planner Export では、既存の Cisco Prime NCS/WCS AirMagnet Planner プロジェクトを
Cisco Prime NCS/WCS にインポートできます。

プランナープロジェクトの作成

サイトプランを開始する前に、プロジェクト名を付け、サイトマップをインポートし、サイト の物理的
特性を指定するなどして、プランナープロジェクトを作成する必要があります。このセクションでは、
プランナープロジェクトの作成方法について説明します。

新しいプランナープロジェクトを作成するには: 

1. メインメニューから File > New Project... を選択します。新規プロジェクトウィザードが
表示されます。
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2. Specify Project Name（プロジェクト名の指定）で、新しいプロジェクトの任意の名前を入力します。
以下のいずれかのオプションを使用してプロジェクトを保存します：

• プロジェクトをデフォルトの場所に保存するには、Next をクリックします。
New Project Wizardのビューが更新されます。

• プロジェクトをデフォルト以外の場所に保存するには、Browse をクリックして任意の場所を
指定し、Next をクリックします。New Project Wizardのビューが更新されます。

Note: デフォルトでは、AirMagnet Planner は、指定した名前を使用してプロジェクトをコンピュータの 
C ドライブに自動的に保存します。
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をクリックして、その場所のサイト マップを見つけて3. (サイト画像のインポート)
インポートします。

4. Unit of Measurementでは、［フィート］または［メートル］を選択します。Floor Plan Dimension
には、イトマップの幅と長さを入力します。Nextをクリックします。

Note: 「Floor Plan Dimensions」とは、フロアプランの画像領域全体（画像に含まれる余白を含む）の
縮尺（フィートまたはメートル）を指します。
寸法に確信が持てない場合は、ここにおおよその値を入力し、後でその値をより正確に再調整する
こともできます。
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5. Environment（環境）には、計画しているサイト環境に似たオプションを選択します。

6. Signal Propagation Assessmentについては、AirMagnet Planner が選択したサイト
環境に応じて自動的に値を割り当てるため、（通常は）何もしません。

Note: AirMagnet Planner は、これらの一般的なサイト環境のそれぞれで RF 信号が伝わる距離の推定に
基づいて、信号伝播評価値を割り当てます。 通常、NetAlly では、プログラムが割り当てるデフォルト値を
受け入れることを推奨します。ただし、独自の値を設定する場合は、入力した値がプログラムによる
サイトデータの補間方法に影響することに注意する必要があります。

7. AP Default Powerには何もしません（通常）。 Next をクリックします。New Project
Wizardのビューが更新されます。

8. Enter Descriptive Textに、プロジェクトの簡単な説明を入力します。(任意）

9. Finishをクリックします。新しく作成されたプランナープロジェクトが自動的にプロジェ
クトウィンドに表示され、サイトマップがマップウィンドウに表示されます。

サイトプランの作成

サイトマップをインポートした後は、AP設定を解析できるように、計画されたオフィスの配置を作成
する必要があります。このセクションでは、AirMagnet Planner の描画ツールを使用して理想的な
オフィスを設計し、その目標を実現するために必要な AP の数を決定します。
以下のリンクをクリックすると、各セクションの説明が表示されます。

• 壁ツールの使用
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• 四角形と任意領域の描画

• APをプランに追加する

• 右クリックメニューの使用

壁ツールの使用

まず、オフィスの壁とドアを設置する必要があります。 以下の手順では、建物の概要のプロセスを
説明します。

1. ツールバーからCreate Wallツールを選択します。

2. マップウィンドウの右上にドロップダウンリストが表示されます。このリストには、固有の
dBドロップレベル（これらの壁がワイヤレスネットワークに与える影響）を持つ、あらかじ
め設定された壁の種類が多数含まれています。配置したい壁のタイプを選択します。

Note: Cisco Prime NCS/WCS Plannerプロジェクトでは、Cisco NCS/WCSタイプの壁のみが 
ドロップダウンメニューに表示されます。

3. 壁の描画を開始する場所をクリックします。
壁の角度が変わる角または点にカーソルを移動し、もう一度クリックします。 壁の曲がり
角やーブに沿って何度もクリックすることができます。壁のこの部分を終了したいときは、
右クリックします。

Note: 壁の描画中に間違った場所をクリックした場合は、キーボードの Ctrl+Z を押してください。 
この機能は、最後にクリックした箇所を元に戻し、繰り返し押すと元に戻ります。
壁の描画をキャンセルするには、Escを押します。ツールはカーソルにデフォルト設定されます。

4. すべての壁が埋まるまで手順 3 を繰り返します。前述のドロップダウンリストから

さまざまな壁のタイプ (窓、ドアなど) を選択できます。

Note: 一般に、互いに 45 度または 90 度の角度でまっすぐな壁を描画する必要があります。 
描画がまっすぐになるようにするには、Shift キーを押したまま壁ツールを並べます。
これにより、パスが 45 度および 90 度の角度にロックされ、直線のパスの描画がはるかに簡単になります。

Automatic Wall Extractionの使用 
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Automatic Wall Extraction (AWE) は、CAD ファイルから壁をインポートするためのプランナー機能
です。 この機能を使用すると、壁を含むレイヤーを選択し、それらの位置に Planner で壁を自動的
に描画できます。

Note: CADイメージの各レイヤーを表示または非表示にした場合、その変更はエクスポートした 
CADファイルに反映されます。 

AWEを使用する場合

サイトプランを開始する前に、プランナープロジェクトを作成する必要があります。これには、プロジェクト
の名前、サイトマップのインポート、サイトの物理的プロパティの指定などが含まれます。この手順は、
サイトマップをインポートするときにCAD図面（拡張子は.dxf、.dwf）をインポートする必要があることを
除いて、他のプランナープロジェクトと同じです。

AWE使用の概要

1. CAD 図面を使用してプロジェクトを作成します。

2. CAD 図面から使用するレイヤーを選択します。

3. 壁を作成/変更します。

4. AP を配置します。

5. 更新を実行してヒートマップを作成します。

6. 必要に応じて壁と AP を操作します。

AWEの使用方法

この機能は以下のように使用します: 

1. Planner または Display のメイン メニューから、File > New Project... を選択します。
New Project Wizardが表示されます。 詳細については、Planner プロジェクトの作成を参照
してください。

2. まだ Planner を使用していない場合 (つまり、Display で新しいプロジェクトを作成した
場合)、[Planner]ブをクリックします。

3. View > Show CAD Layers を選択する。次のようなウィンドウが表示されます。
このウィンドウで、マップに表示する CAD レイヤーを決定できます。
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4. Select all layersチェックボックスをクリックし、もう一度クリックします。 これで全ての

チェックボックスがクリアされます。次に、マップに表示したいレイヤーをクリックします。

以下のようにドロップダウンメニュー/チェックボックスを使用します: 

• Layout:  CADファイルによっては、複数のレイアウトが含まれている場合
があります。 [Layout]のドロップダウンボックスを使用して、CADファイル
内の利用可能なレイアウトから選択します。

• Select all Layers: すべてのレイヤーを選択/選択解除します。
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• View black and white: CADファイルによっては、様々なレイヤーに色を使用
しているため、ヒートマップの見やすさの妨げになる場合があります。
すべてのレイヤーをデフォルトの白黒表示にするには、このオプションを選
択します。

Note:  CAD図面には多数のレイヤーが存在する場合があります。 
選択肢を、実際の壁を表現する要素や、またはフロアプランを操作する際に価値のある要素を
含むものに限定するようにしてください。

5. レイヤーの選択が完了したら、「OK」をクリックします。

6. [File] > [Extract Wall Objects from CAD…]（CADから壁面オブジェクトを抽出）を選択します。
以下のようなウィンドウが表示され、表示するために選択したレイヤーが表示されます。

7. Layer欄のチェックボックスをクリックして、レイヤーを選択します。

8. 任意の行の壁タイプをクリックしてドロップダウン メニューを開き、そのレイヤーに使用する
壁タイプを選択できます (デフォルトはBrick Wall)。

利用可能な選択肢は、Dry Wall, Concrete Wall, Thick Wall, Metal Door, Heavy Door, Brick 
Wall, Light Door, Cinder Wall, Plasterboard Wall, Thin Window, Glass Wall with Metal Frame, 
Window Officeです。

任意の行で[db Drop]をクリックし、db Dropの値を変更します。

9. 以下のチェックボックスを選択または選択解除します：
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• Ignore line segments less than: 多くのCAD図面には、RF伝播には寄与しな
いが、大量の「visual noise」を構成する短い線要素が含まれています。 この
オプョンは、このvisual noiseを軽減する方法を提供します。

• Combine parallel segments if within: 多くのCAD図面では、壁を2本の平行な
線で表現しています。このオプションを無効にすると、壁の数が2倍になって
減衰が2倍になることがあります。

これらのオプションを使用することで、CADファイルから実際の壁セグメントではないアーティファ
クトをインポートすることを回避できます。

10. Overwrite Existing Planner Wallsをクリックします。 以下のようなマップが表示されます。これらの
オプションは、垂直線と水平線 (対角線ではありません) 用です。

Note: レイヤーを追加するには、Append to Existing Plan をクリックします。  
同じレイヤーを複数回追加しないように注意してください。

11. 任意の壁またはエリアタイプを選択し、右クリックします。ポップアップメニューが表示され、壁の
セグメントを削除したり、各セグメントのプロパティを変更したりできます。 詳細については、右クリックメ
ニューの使用を参照してください。

12. ヒートマップを作成するための AP の追加、または個別またはグループの壁の操作に関する
追加情報については、『Survey Pro ユーザーガイド』の以下のセクションを参照してください：

• 壁ツールの使用（理想的なオフィスを設計し、その実現のために必要なAP数
を決定するその目標を実現するために必要なAPの数を決定します)

• 減衰エリアの描画（壁などのデシベル値の変更壁などのオブジェクト）

• プランへのAPの追加

• 802.11 AP オプション
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• 右クリックメニューの使用（配置されたオブジェクトの修正または削除）

13. 以下のように壁の選択を操作することもできます：

a. Ctrl キーを押したまま壁を選択すると、選択した壁のリストに
その壁が追加されます。

b. Ctrl キーを押したまま、選択した壁をもう一度クリックすると、
選択した壁のリストから削除されます。

c. 壁が選択されていない状態でどこかをクリックすると、すべて
の選択が解除されます。

d. 他のタイプの Planner オブジェクト (AP、減衰エリアなど) をク
リックすると、すべての壁の選択が解除されます。

e. 選択または選択されていない壁を Ctrl キーを使用せずにク
リックすると、その壁がリスト内で唯一の選択オブジェクトになります。

f. 壁のグループを選択した状態で、削除、移動（グループとし
て）、プロパティの変更ができます。複数の壁が選択されている場合、サ
イズ変更は機能しません。

g. グループ内のすべての壁の減衰またはタイプが同じでない場
合、Wall Propertiesダイアログのタイプと減衰の項目は空白になりま
す。

h. Wall Propertiesダイアログで、選択した減衰値にすべて設定し
ます。すべての壁のタイプや減衰量が同じでない場合は、Wall
Propertiesダイアログに警告が表示されます。 この場合、タイプ、"dB
Drop "フィールドは空です。

i. Selectアイコンを選択した状態でShiftキーを押しながらマウス
を動かすと、最初の選択ポイントからマウスを離したポイントまで、ラ
バーバンド効果が作成されます。ラバーバンドエリアの完全に内側にあ
る壁セグメントは、選択された壁リストに追加されます。このテクニック
は壁にのみ適用されます。 ラバーバンドエリア内の他のプランナーアイ
テム（AP、減衰エリアなど）は選択されません。

j. ラバーバンドで選択する前に選択されていた壁は、ラバーバン
ドの範囲内でない限り、再び選択されることはありません。他のオブジェ
クトが以前に選択されていた場合、そのオブジェクトは選択解除されま
す。

14. ツールバーの （Refresh）アイコンをクリックすると、ヒートマップが生成されます。

Note: 抽出された壁は、ユーザーが描いた壁と同じように移動、変更、削除できます。 

減衰エリアの描画

壁のレイアウトが完了したら、オフィスの長方形の内部レイアウト コンポーネント (キュービクル、
オフィスなど) を描くことができます。 以下の手順に従ってプロセスを進めてください。
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Note: 同じ減衰スペースに「壁」と「エリア」の両方を使用することはできません。 
例えば、小さなオフィスを壁で囲む場合、オフィスの中に減衰エリアを作らないでください。

四角形の領域を描画するには:

1. ツールバーから「Create Rectangular Attenuation Area」ツールを選択します。

2. 壁ツールと同様に、マップビューの右上にドロップダウンリストが表示されます。
このリストには、あらかじめ減衰指数が設定されたさまざまな四角形のエリアが含まれ
ています。配置したいエリアタイプを選択します。

Note: 上に表示された数値は、スペースのタイプごとに組み込まれた減衰指数を表します。 
これは壁の dB 値に似ていますが、減衰指数はワイヤレスカバレッジに対するエリアの影響を
指しますが、dB ドロップは単一スポットでの即時の減少を指します。
減衰指数の詳細については、「Attenuation Index(減衰指数)」を参照してください。

3. 指定したいエリアの角をクリックする。マウスカーソルを反対側の角に移動し、もう一度
クリックしてエリアを描画します。

4. さらに描画したいエリアがある場合は、手順 3 を繰り返します。

任意のエリアを描画する

任意のエリアを描画するツール(arbitrary tool)は壁ツールと非常によく似た機能を持ちます。 ただし、
壁を描画する代わりに、rectangular areaツールで定義したエリアと同様の領域を定義します。 
完全な四角形ではないキュービクルまたはオフィスエリアがある場合、このツールを使用すると、
それを正確に定義できます。

任意のエリアを描画するには:

1. Arbitrary Area toolツールを選択し、ドロップダウンリストから材料を選びます
（Rectangular Area toolの場合と同じです）。

2. 描画を開始したい点を 1 回クリックします。 以前の壁ツールを使用したのと同じ方法で、
定義したいエリアの輪郭を描きます。 右クリックして描画を停止し、エリアを定義します。

Note: 壁ツールと同様に、Shift キーを押したままにして、線が互いに 45 度および 90 度の角度でまっすぐに
なるようにします。 

さらに不規則なエリアがある場合は、ステップ 2 を繰り返します。
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APをプランに追加する

オフィスマップの設計が完了したら、AP を配置する予定の場所に配置できます。 あるいは、任意に 
1 つを配置し、そのカバーエリアがどのようなものであるかを確認して、次のエリアをどこに配置する
かを決定することもできます。 これにより、サイトに最適なカバレッジを提供する AP の数と配置を
決定できます。

AP を配置するには:

1. ツールバーの「Create AP」をクリックします。

2. AP を配置する場所をクリックします。 これと同じ方法で、必要な数の AP を配置します。

3. 通常のカーソルに戻すには、Selectツールをクリックするか、Esc キーを押します。

4. AP のいずれかを右クリックし、[AP Properties...] を選択します。[AP Properties]ダイアログ
ボックスが表示されます。
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5. 新しい AP の AP 名を入力します。

6. この構成に AP Model名を付け、モデルを保存する      ことで、特定の構成プロパティ

のセットを保存することができます。これは後で複数のAPに同じ基本設定を与えるの

に便利です。既存のモデルを削除するには、モデルを選択して delete      をクリックし

ます。

7. ダイアログボックスの次のセクションには、2.4 GHzと5 GHzの2つのタブがあります。

この2つのタブは、関連するメディアタイプの設定を制御します。

Note: 以下の表は、マルチフロアプランナーの AP Properties ダイアログにもある項目と関連する説明です。 
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項目 説明

Channel デバイスが動作するチャネルを入力します。

Enable 
現在のタブのメディアタイプを有効にするには、このボックスにチェックを入れます。
デバイスが1つのメディアタイプのみで動作する場合は、該当しないタブを無効にし
てください。

MAC Address このフィールドにはデフォルト値が入力されます。 必要に応じてこれを変更して、
仮想 AP を識別できます。

Full Mac Address マルチフロアプランナーのみ。異なるフロアの AP が同じ MACアドレスを持つ場合、
フィールドに自動入力されます。

IP Address 必要に応じて IP を入力し、仮想 AP を識別します。マルチフロアプランナーには
ありません。

SSID 必要に応じてSSIDを入力し、仮想APを識別します。

Transmit Power (mW) APの実際の送信電力設定に近い数値を入力します。

Antenna 

このセクションでは、デバイスが使用するアンテナのタイプをカスタマイズできます。
お使いのデバイスがドロップダウンリストに表示されている場合、それを選択すると、
デバイスのカバレッジフィールドが左の図に表示されます。表示されない場合は、ア
ンテナパターンをカスタマイズすることができます。アンテナを選択した後、スライ
ダーを使用して、周囲に対するアンテナの方向を変更できます。

11n support AP が 802.11n 対応であることを指定するには、このオプションをオンにします。
詳細は、「802.11 APオプション」を参照してください。

Media Type マルチフロアプランナーのみ。 2.4 GHz または 5 GHz タブに基づいて、必要なオプ
ションを選択します。

Location 
APの高さ（フィート）を入力します。XとYのフィールドは、地図上のデバイスの位置を
示します。レイアウトがグリッド形式の場合は、これらを指定します。

Note APの説明を入力します（オプション）。

6. 「OK」をクリックするとAPが配置されます。先に配置した他のAPも同じ手順で

修正してください。

7. (Refresh)  をクリックすると、Wi-Fi信号強度の予測カバレッジのヒートマップビューが
表示されます。

8. カーソルツールを選択し、目的の場所にドラッグすることでAPを移動できます。 変更を加えた後、
「Refresh」をクリックしてビューを更新します。

Note: サイトマップ上に表示されるAPアイコンは、メディアタイプによって色が異なります。 
802.11a/nのAPは青色、802.11b/g/nはオレンジ色、両方のメディアを利用するAPは青色とオレンジ色が
半分ずつ表示されます。

AirMagnet Planner は、サイトプランで現在使用されているすべての AP のリストを維持します。 
このリストにアクセスするには、[View] > [Show AP List] をクリックします。

設計作業中に AP を削除した結果、既存の AP の番号付けにギャップが生じた場合、Survey は
デフォルトの番号付けスキーム（「AP-#」）に適合する、マップに配置されたすべての AP の番号付けを
再順序付けすることができます。[View]メニューの[Re-Sequence AP Numbering]オプションを選択して、
自動番号付けされたAPの順序を変更します。
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Displayビューでは、さらに多くのヒートマップデータタイプを使用できます。

802.11 APオプション

802.11nに対応しているため、最新の無線規格を使用した設置、シミュレーション、カバレッジ評価が
可能です。

1. PlannerビューでAPを右クリックし、AP Properties を選択します。

2. 希望の帯域タブ (2.4 GHz または 5 GHz) をクリックします。

3. 「11n support」にチェックを入れ、「Properties」をクリックします。

「802.11n Properties」ダイアログボックスで選択できる項目については、下表を参照してください。

オプション 説明

Max MCS 

MCS (変調およびコーディング スキーム) は 0 ～ 76 の範囲の整数値です。ただし、現在の 
802.11n デバイスは最大 31 までの MCS 値のみに対応しています。MCS の選択は、AP が
サポートする最大データ転送レートに対応します。

Max Frame Size 
従来のデバイスがサポートする最大サイズは 4 KB ですが、802.11n デバイスは最大 64 
KB のフレームサイズをサポートします。このプロセスでは、フレーム数を減らすことでネット
ワーク内のワイヤレスオーバーヘッドを最小限に抑えます。
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required per transmission. 

Expected Op. 
Mode 

802.11n デバイスには、いわゆるGreenfieldモードで動作する機能があり、展開は純粋に 
802.11n 対応デバイスで構成されます。これは個々の AP で構成される設定です。 グリー
ンフィールドモードに設定された 802.11n AP は、レガシー (802.11a/b/g) クライアントに
サービスを提供できなくなります。

Note: Plannerプロジェクトに 802.11n AP を配置した後、データが処理されるとき 
(つまり、チェックするとき)、各 AP の予想される動作モードの選択がチェックされます。  

Greenfield モードに設定されている AP の範囲内にレガシーデバイスを配置したことを
システムが検出した場合、AP List ダイアログボックスが表示され、
Expected Operating Mode と実際の動作モードが一致しないことが通知されます。 
802.11n デバイスの最適な動作を保証するには、純粋なグリーンフィールド デバイスと
レガシー AP を混在させないようにしてください。

Protection 
Method 

Mixed Mode オプションが選択されている場合、AP で使用されている保護メカニズムのタイ
プを指定できます。

Channel 

802.11n デバイスは、ほとんどの標準的なレガシーデバイスが利用する 20MHz チャンネル
とは対照的に、40MHz チャネル幅で動作することができます。40 MHz 幅に対応するため
に、AP を 2つの 20 MHz チャネルで送信するように設定することができます。この場合、希
望するチャネルを選択し、使用するセカンダリチャネルが選択したチャネルの上か下かを
指定します。

Block ACK 

802.11n 仕様はブロック ACK フレームと呼ばれる新しいフレームタイプを提供し、AP が 1 
つの ACK フレームで複数のフレームのブロックを確認することを可能にします。対照的に、
レガシーデバイスは、受信したフレーム毎に ACK フレームを送信する必要があり、その結
果、ネットワークのオーバーヘッドが大幅に増加します。ブロック ACK 機能により、802.11n
デバイスはこのトラフィック負荷を軽減し、結果的にネットワーク全体のパフォーマンスを向
上させることができます。

Short Guard 
Interval 

ガードインターバルは、データ送信の間に経過する時間の期間を指します。一般的にShort 
Guard Intervalは、伝搬遅延、エコー、反射などの潜在的な無線の危険を防ぐのに役立ちま
す。802.11n 仕様では、現在 2 つのガードインターバルのオプションがあります： 400 ns と 
800 ns です。この設定は、AP の管理インターフェイスを使用して指定できます。デフォルト
では、ほとんどの 802.11n デバイスは 800 ns に設定されています。

AP List 

[View] > [Show AP List] をクリックすると、サイトプランに現在配置されているすべての AP のリストを
すばやく表示できます。 このオプションにより、[AP List] ウィンドウが開きます。

Note: Multi Floor Planner では、列の説明は似ていますが、AP List テーブルは多少異なって見えます。 
2つのテーブル間の相違点はテーブルの説明に記載されています。
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Note: AP Listには、APごとに 2 つのエントリが表示されます：1 つは 802.11a 用、もう 1 つは b/g 用です。
これにより、特定のAPでどのメディア タイプを有効にするかを簡単に変更できます。
このウィンドウには、APのプロパティに関する詳細を提供するいくつかの列が含まれています。

列 説明

Group Change 
電源とアンテナの設定を一括変更するのに便利です。一括変更するAPを選択します。
グループ変更にチェックを入れる。表の項目を変更する。選択した同じタイプのAPがす
べて変更されます。

Select/Unselect All 
AP 

このオプションを使用して、すべての AP を選択または選択解除します。

このフィールドにチェックが入っている場合は、AP がロックされているため、
Planner Advisor によって変更できないことを示します。

AP Name APの名前。

Channel APが設定されているチャンネル。

Media APのメディアタイプ。

Enabled このフィールドにチェックを入れると、APがプラン上で有効になっていることを示します。

Power AP の電力設定 (ミリワット単位)。

Antenna AP が現在使用しているアンテナ。

Ch. Width AP が使用しているチャネル幅。

Config Op. Mode 

AP のプロパティで指定された動作モード： Greenfield：802.11nデバイスのみ、Mixed：
802.11nデバイスとレガシーデバイスを併用する場合、 Legacy：純粋なレガシー
（802.11nデバイスなしなど）実装の場合。Multi Floor Plannerには、802.11acを含む
Mixed VHTも含まれます。

Actual Op. Mode 

導入が最適に構成されている場合、[Actual Op. Mode フィールドは Config Op. Mode 
列の値を反映します。上図に示すように、デバイスのコンフィグ値が実際の設定と矛盾
する場合（例えば、環境にレガシーデバイスが存在するときに AP が純粋なGreenfield
モードに設定されている場合）、Actual Op. Mode は赤文字で強調表示されます。Mode
は赤文字でハイライトされ、競合を示します。マルチフロアプランナーにはありません。

AP のプロパティを変更するには、AP Listで AP をダブルクリックして AP Properties ウィンドウを
表示します。
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Note: レガシーAP がまだ存在する配置で 802.11n AP をグリーンフィールドモードに設定している場合、 

 (Refresh) is clicked if you have 

(Refresh)    をクリックすると AP Listが自動的にポップアップ表示されます。
これは、Greenfieldの制限による競合の可能性を通知するためです。グリーンフィールドのデプロイメントでは、
古いデバイスはワイヤレスネットワークのデータレートを低下させる可能性があるため、

レガシーデバイスを存在させることはできません。

右クリックメニューの使用

配置されたオブジェクトは、右クリックして必要なオプションを選択するだけでいつでも変更
または削除できます。

Note: Locked AP および Default AP オプションは、ユーザーが AP を右クリックした場合にのみ表示されます。 

オプション 説明

Properties... 選択したオブジェクトに応じて、AP PropertiesまたはWall/Area Propertiesダイアログ
ボックスを開きます。

Delete 選択したオブジェクトを削除します。

Locked AP 選択したAPをロックします。 これにより、Planner Advisor は APのプロパティを変更で
きなくなります。

Default AP 
選択した AP のプロパティを Planner のデフォルトの AP 設定として指定します。 
これを選択した後に配置された AP には、現在の AP の設定が反映されます。

Select 2.4 GHz AP 
or Select 5 GHz AP 

AP に対して 1 つまたは 2 つのチャネルが有効になっているかどうかに応じて、このオ
プションにより 1 つを選択できます。 これは、データウィンドウで単一のチャネルを選択
するのと同じように動作します。

プランナーアドバイザーの使用

AirMagnet Planner のアドバイザー機能は、サイトプラン上の AP のレイアウトを最適化するのに
役立ちます。

アドバイザーを使用する前に：

1. サイトプラン上に一般的なエリア、壁、キュービクル、その他のエリアを描きます。

2. ツールバーのツールを使用して、カバレッジエリアと AP 除外エリアという 2種類のエリアを指定してアド
バイザの焦点を絞ります。

・AP のカバレッジ エリアは青色の「+」で表されます。 これらのエリアは、サイトプランの中で絶対
に信号が届く必要があり、APを含むことができる部分を表しています。
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・AP除外エリアは赤い「-」で表されます。これらのエリアはAPを配置できないエリアです。

アイコン 名前 説明

Create Rectangular 
Coverage/AP Exclusion 
Area 

マップ上に四角形のカバレッジエリアまたは AP除外エリアを描画しま
す。

Create Arbitrary 
Coverage/AP Exclusion 
Area 

マップ上に任意のカバレッジまたは AP除外エリアを描画します。 この
ツールは、不規則な形状のエリア(つまり、個室やオフィス以外などのエ
リア)に適しています。

Create Elliptical 
Coverage/AP Exclusion 
Area 

マップ上に楕円形のカバレッジエリアまたは AP除外エリアを描画しま
す。 直線では描きにくい部分に便利なツールです。

カバレッジエリアと除外エリアのマーク付けが完了したら、Advisor を使用して推奨される AP レイアウト
を生成します。

APのカバレッジエリアと除外エリア

このセクションでは、Planner Advisorが可能な限り正確な結果を得るためのサイトプランの設定方法に
ついて説明します。Advisorが最適なレイアウトを生成できるように、カバレッジエリアとAP除外エリアを
適切にレイアウトすることが重要です。

Note: Advisorの結果はユーザーの入力に大きく依存するため、プランのレイアウトが詳細であればあるほど、
より正確な結果が得られます。
サイトの最適なレイアウトを完全に決定する唯一の方法は、セットアップをテストし、AirMagnet Survey
ソフトウェアを使用してサイトサーベイを実行することです。

カバレッジおよび AP除外エリアを描画するには：

1. 描画するエリアに最適なカバレッジツール（四角形、任意、楕円）を選択します。
エリアを定義するのと同じように、ツールを使って目的のエリアを定義します。

2. 必要なエリアをすべて定義するまで、このプロセスを繰り返します。

3. AP除外エリアについても手順 1 ～ 2 を繰り返します。

4. これでPlanner Advisorの解析準備が整いました。

Advisorレイアウトの生成

サイト計画が適切に定義されたので、Planner Advisor は最適な APレイアウトを生成できます。

Advisorレイアウトを生成するには:

1. ツールバーの（Advisor）  ボタンをクリックする。Advisor Criteria ダイアログが表示されます。
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2. ダイアログ情報に必要な変更を加えます。

フィールド 説明

Minimum Signal 
Strength 
Coverage 

このフィールドは、カバレッジエリア内のどのポイントでも必要な最小強度を定
義します。カバレッジが必要なエリアでは、信号強度がこの値を下回ることは
できません。

Transmit Power このフィールドは、Advisor によって配置された AP の送信電力を定義します。

Band このフィールドは、Advisorの配置されたAPによって使用する域を定義します。

Omni Antenna 
Gain 

このフィールドは各 AP のアンテナゲインを定義します。AdvisorのAPは
無指向性アンテナを使用することに注意してください。

AP Height 
APの高さは信号のカバレッジエリアに直接影響します。高い場所に設置され
たAPは、標準的な天井の高さに設置されたAPほど広い範囲をカバーできま
せん。

Max MCS 

802.11n のみ: Modulation Coding Scheme(MCS) は 0 ～ 76 の範囲の整数値
ですが、Planner は最大 15 までの値のみをサポートします。MCS の選択
は、AP がサポートする最大データ転送レートに対応します。

Frame Size 

802.11nのみ： 802.11nデバイスは、従来のデバイスがサポートする最大4KB
のフレームサイズに対し、最大64KBのフレームサイズをサポートします。この
プロセスにより、1回の送信に必要なフレーム数を減らすことで、ネットワーク
のワイヤレスオーバーヘッドを最小限に抑えます。

Channels... このボタンをクリックするとChannel Allocationダイアログボックスが開き、
Planner Advisor機能が使用できるチャネルを正確に指定することが
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できます。 詳細については、以下の詳細情報を参照してください。 使用する
各帯域に対して最低3つのチャンネルを選択する必要があることに注意してく
ださい。

Enable 802.11n 
Support 

Advisor が 802.11n デバイスを配置できるようにするには、このオプションを
チェックします。上記の Max MCS と Frame Size フィールドを変更するに
は、802.11n supportを有効にする必要があることに注意してください。

Legacy to 
802.11n: One-
for-one 
Replacement 

このオプションを有効にすると、Planner Advisor はレガシー サイトプランにす
でに存在する AP を 802.11n 対応の AP に置き換えます。

3. 「OK」をクリックしてアドバイザを開始します。 Advisor はサイトデータを処理し、

4. (Refresh)        をクリックすると、サイトの予測ヒートマップが表示されます。

APの位置をテストして、フロアプラン上に APを配置します。

Planner Advisorのチャネル割り当て

Channel Allocationダイアログボックスを使用すると、Planner Advisorで使用可能なチャネルを簡単に
指定できます。この機能を使用すると、2.4GHz帯と5GHz帯への割り当てが制限されている地域の
特定のチャンネルを削除するようにプランナーをカスタマイズできます。  
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Note: 2.4GHzと5GHzの両方を有効にするには、Advisor CriteriaダイアログのBandドロップダウンで 

2.4/5GHzオプションを選択する必要があります。

ダイアログボックスの上部にあるタブで、2つの主要なワイヤレスバンドを簡単に切り替えることができ
ます。使用するチャネルを指定するには、希望する各チャネルの「Usable」ボックスをチェックするだけ
です。Enable AllとClear Allボタンを使って、すべてのチャンネルを素早くチェックしたり外したりするこ
とができます。「Default」ボタンをクリックすると、Planner のデフォルト設定が自動的に復元されます。 
上の図に示すように、2.4 GHz 帯域ではチャネル 1、6、および 11 がデフォルトでチェックされていま
す。 5 GHz 帯域の場合、チャネル 36、44、および52 が自動的に選択されます。

3. [OK]をクリックして、[Channel Allocation]ダイアログを閉じます。

4. [OK]をクリックして Advisor を起動し、サイトデータの処理とAPの場所のテストを開始
します。

5. プロセスが完了すると、APがプラン上に配置されます。サイトの予測ヒートマップを表示

するには、（Refresh）       をクリックします。
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Plannerレポートの表示 

AirMagnet Planner の内蔵レポート機能は、現在のサイトプランに関連するレポートデータを自動的に
生成します。このレポートには、計画された信号カバレッジ、AP の位置、および配置されたAPのリスト
を表示する画面が含まれます。APリストには、名前/MACアドレス、アンテナタイプ、チャネル割り当て
など、配置された各APの詳細情報も含まれます。

Plannerレポートを生成するには:

1. サイトプランを設定した後、「Reports」をクリックします。

2. Reportビューから、左上のPlanner Reportを選択します。
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3. 上部の矢印ボタンを使用して、レポートページ間を移動します。

アドバイザレイアウトの生成

ここにトピックのテキストを入力します。

CADへのエクスポート 

プロジェクトまたはMulti Floor PlannerプロジェクトのフロアにCADイメージ（.dwg）を使用した場合、
[Export to CAD]オプションを使用すると、イメージに追加されたAPや壁データと共にCAD（.dwg）ファ
イルにエクスポートすることができます。

Note: CADイメージの個々のレイヤーの表示/非表示を選択した場合、その変更はエクスポートされた
CADファイルに反映されます。 

CADにエクスポートするには:

1. Fileメニューから［Export to CAD］を選択します。Export to CADダイアログが開きます。
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2. (Planner の場合) ファイル名を指定します:

o エクスポートしたファイルを保存するパスを「Folder」テキストボックスに入力
します。テキストボックスの右にある参照ボタンをクリックしてパスを設定
することもできます。

o 「File Name」テキストボックスで、自動入力されたファイル名を使用するか、
ファイル名を修正します。ファイル拡張子は .dwg である必要があります。

3. (Multi Floor Plannerの場合）[File Name]テキストボックスにファイル名とパスを入力します。
テキストボックスの右にある［参照］ボタンをクリックして、ファイルエクスプローラで場所を
選択することもできます。

4. ファイルのエクスポートオプションを選択します。

o APs チェックボックス：アクセスポイントをCADファイルのレイヤーとして
エクスポートします。

o AP Names チェックボックス：アクセスポイントのアイコン名を CAD ファイルの
レイヤーとしてクスポートします。

o Walls: フロアプランの壁をCADファイルのレイヤーとしてエクスポートします。

o (Multi Floor Plannerのみ) Size： APアイコンと名前のサイズを設定します。

o (Plannerのみ) Fill Mode ： 壁の厚さを塗りつぶすか塗りつぶさないかを
指定します。Force Trueをチェックすると、壁が塗りつぶされます。
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o [Color]オプションは、Planner または Multi Floor Planner のデータの色を設
定します。

 Plannerで、Setをクリックしてcolor selectionダイアログを表示し
ます。

 Multi Floor Plannerで、Colorボックスをダブルクリックしてcolor
selectionダイアログを表示します。

5. 「Export」をクリックしてファイルを保存します。 Planner または Multi Floor Planner
データは、CADファイルに追加レイヤーとして保存されます。 元のCADファイルの
レイヤーは上書きされません。

TIP: エクスポートしたファイルを確認するには、無料のCADファイルビューアを使用します。 
APアイコンのサイズを確認したり、さまざまなレイヤーを表示したり、Planner または Multi Floor Planner 
データがどのように表示されるかを確認できます。




